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Resumo: Guias são ferramentas criadas para auxiliar na precisão de procedimentos cirúrgicos. No caso da osteotomia 

periacetabular, as guias são geradas a partir de imagens médicas, obtidas por tomografia computadorizada, de forma 

a se adaptarem perfeitamente ao osso pélvico do paciente. Nas guias são criadas fendas para a inserção apropriada 

de formões que realizam a osteotomia e, finalmente, são construídas através do processo de manufatura aditiva 

(impressão 3D). Uma vez que o sítio cirúrgico é de difícil acesso e com tamanho restrito, é proveitoso que as guias 

sejam vazadas para aumentar a visibilidade local, além de possuírem dimensões que sejam compatíveis com essa 

região, a fim de não comprometer o procedimento cirúrgico. Entretanto, devido ao impacto dos formões, esforços 

podem ser transmitidos às guias e por isso é necessário que elas sejam mecanicamente resistentes. Através do método 

de elementos finitos, diferentes guias são testadas a fim de verificar sua eficiência mecânica, utilizando programas de 

edição de malha para a geração de padrões distintos. Devido às dificuldades em se converter imagens médicas em 

modelos geométricos, alguns protocolos são testados no intuito de minimizar os artefatos que impedem a importação 

dos modelos para os programas de análise. São utilizadas técnicas de limpeza, correção e suavização de malhas e, para 

agilizar a tarefa, um código em python é criado, automatizando a geração dos mesmos, de acordo com parâmetros 

definidos. 

Palavras-chave: Modelagem geométrica, Modelagem computacional, Otimização topológica, Malhas STL, Modelos 

específicos de pacientes. 

 

1. Introdução 

Conforme mencionado em Schröder (2020), a displasia do desenvolvimento do quadril (DDQ) é uma condição em 

que a cabeça femoral guarda uma relação anormal com o acetábulo, cuja gravidade varia de casos de instabilidade ao 

nascimento até a luxação congênita. A cirurgia de osteotomia periacetabular (OPA) é o tratamento de escolha na DDQ 

de pacientes esqueleticamente maduros sintomáticos e os resultados incluem a melhora da qualidade de vida, a 

modificação da história natural da doença e eventualmente a prevenção da coxartrose.   

 

 No entanto, sendo uma cirurgia tecnicamente desafiadora, com longa curva de aprendizado e associada a algumas 

complicações graves, vislumbrou-se a possibilidade de aplicar a tecnologia da prototipagem rápida (PR), com 

planejamento cirúrgico tridimensional (3D) e impressão de guias customizados como auxiliares à essa cirurgia. 

 

 Essas guias são feitas a partir de um processo que envolve, principalmente, a manipulação de imagens médicas 

adquiridas através de um exame de tomografia da região pélvica do paciente. E, como o sítio cirúrgico é bem reduzido 
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e de difícil acesso, faz-se necessário que a guia tenha uma topologia ótima. O objetivo deste trabalho é realizar 

simulações de esforços de tensão a fim de aplicar uma otimização no modelo com base nos resultados obtidos. 

2. Materiais e Métodos  

Nesta seção será apresentado todo o processo de construção da guia cirúrgica, desde a obtenção do modelo 3D da 

pelve do paciente até o procedimento de otimização. 

 

2.1. Construção do modelo 3D da pelve humana 

                                                                                                                                                                                                                                   

 De acordo com Amaro Júnior and Yamashita (2001), a tomografia computadorizada (TC) é uma técnica de imagem 

médica que combina raios-X e computação para criar imagens detalhadas do interior do corpo. Durante um exame de TC, 

o paciente é colocado em uma mesa que desliza para dentro de um scanner em forma de anel. Enquanto a mesa se move, 

o scanner emite uma série de raios-X através do corpo em várias direções. 

 

 Os detectores no scanner medem a quantidade de radiação que passa através do corpo e convertem essas 

informações em sinais elétricos. Um computador processa esses sinais para criar imagens transversais (ou "fatias") do 

corpo em diferentes planos. Essas imagens detalhadas permitem que os médicos examinem órgãos, ossos e tecidos de 

forma mais precisa do que as radiografias convencionais. 

 

 A partir desse exame, é possível obter um modelo 3D de diversas estruturas internas do corpo como órgãos e ossos, 

como por exemplo da região pélvica que são nosso objeto de interesse. Seguindo um padrão internacional, os arquivo de 

um exame de TC são salvos no formato DICOM (Digital Imaging and Communications in Medicine), que é utilizado em um 

programa para manipulação e visualização de imagens médicas a fim de que seja gerado um modelo tridimensional da 

pelve. 

 

 No estudo em questão foi utilizado o InVesalius, um software nacional de código aberto disponível gratuitamente, 

conforme mencionado em Amorim et al. (2011). Inicialmente, importamos o arquivo DICOM do exame de TC e em seguida 

é feita a seleção da área a ser transformada. Esse seleção pode ser feita de forma pré definida pelo sistema ou escolhendo 

manualmente um espectro de densidade onde só serão selecionadas as partes que estiverem dentro desse limiar 

previamente estabelecido. 

 

 Após selecionada a área de interesse, a malha tridimensional é finalmente criada, conforme ilustrado na figura 1. 

Entretanto, por mais minuciosa que seja a seleção da área de interesse, pode ocorrer a criação de malha 3D de outras 

partes por terem densidades próximas. Para resolver este problema, é possível aplicar configurações à superfície 3D a fim 

de que seja mantido somente a região pélvica. Com o modelo finalmente configurado, fazemos a exportação no formato 

STL (Stereolithography).  

 

 

Figura 1. Modelo 3D da pelve humana construído no InVesalius. 
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2.2. Construção da guia cirúrgica 

 

 A partir do modelo 3D da pelve no formato STL, utiliza-se um software de modelagem 3D para a criação da guia 

cirúrgica. Conforme mencionado em Saravia-Rojas et al. (2021), o MeshMixer é um programa gratuito desenvolvido 

pela Autodesk, que será utilizado nesta etapa para manipulação do modelo a fim de simular o procedimento cirúrgico 

findando na produção da guia. 

 

 Primeiramente, o modelo da pelve obtido no InVesalius é importado conforme ilustrado na figura 2. Em seguida, 

são seguidos alguns protocolos básicos, como a correção de algumas falhas e simplificação da malha que geralmente 

vem muito densa, tornando sua manipulação impraticável a depender do poder de processamento do computador 

utilizado. 

 

 

Figura 2. Modelo 3D da pelve construído no InVesalius e importado para o MeshMixer. 

 

Nesta etapa, o cirurgião realiza uma simulação da OPA, posicionando placas retangulares (formões) na pelve 

criando cortes afim de separar o acetábulo. Com os formões devidamente posicionados, é selecionada uma área ao 

redor e com a funcionalidade separate é criado uma região a parte do resto da pelve. Agora, utilizando a funcionalidade 

extrusion, é criada uma espessura de aproximadamente 10mm desta área a parte, ilustrado na figura 3. Após isso, com 

a operação boolean diference são realizadas as fendas no local onde os formões foram introduzidos.  
 

  

Figura 3. Modelo 3D da guia cirúrgica extrudada e sua relação com os formões púbico (roxo), coluna (vermelho) e ilíaco (verde). 
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Com isso, tem-se o modelo inicial da guia cirúrgica pronto, apresentado na figura 4. Após alguns protocolos para 

correção de algumas falhas na malha que eventualmente podem ocorrer, o modelo pode ser exportado (ainda no 

formato STL) para ser impresso através de uma impressora 3D. E assim, auxiliar o cirurgião durante o procedimento de 

OPA uma vez que, quando realizada a operação booleana, as fendas são formadas exatamente na mesma angulação 

que foram colocados os formões. Dessa forma, a guia será utilizada principalmente para guiar o posicionamento dos 

formões para realizar os cortes que irão separar o acetábulo da pelve para que seja feito seu reposicionamento durante 

o procedimento cirúrgico. 
 

  

Figura 4. Modelo 3D da guia cirúrgica feito no MeshMixer. 

2.3. Simulação dos esforços na guia utilizando o ABAQUS 

 

 Segundo consta em Börgesson (1996), o ABAQUS é um software de análise de elementos finitos (FEA) amplamente 

utilizado para simulação e análise de problemas complexos de engenharia e ciência, desenvolvido pela Dassault 

Systèmes. O programa permite modelar, simular e analisar o comportamento de estruturas, componentes e materiais 

em uma variedade de campos, incluindo engenharia civil, mecânica, aeroespacial, automotiva e biomédica. 

 

 O software utiliza a técnica de elementos finitos, que divide as geometrias complexas em elementos menores, 

permitindo a modelagem detalhada de respostas estruturais, térmicas e fluidodinâmicas sob várias condições de carga 

e ambiente. Além disso, oferece recursos avançados para simulações estáticas e dinâmicas, análise de não linearidades, 

análise térmica, acoplamento de múltiplas físicas e muito mais. 

 

 Partindo disso, a guia que foi produzida no MeshMixer foi importada para o ABAQUS, a fim de serem realizadas as 

simulações dos esforços sofridos, principalmente, através das fendas onde será colocado o formão durante a cirurgia 

para realizar a fratura do osso. Os resultados obtidos são de extrema importância no processo de otimização.  

Para importar a guia para o programa, utilizamos o seguinte passo a passo: Plug-ins -> Tools -> STL Import. 

 

 Com o arquivo devidamente importado, é necessário criar volume em nosso modelo pois o STL é somente uma 

"casca". Então, para criar esse volume, seguimos os seguintes passos: Mesh -> Edit -> Mesh -> Convert tri to tet. 

 

 Agora como o modelo devidamente preenchido, aplicamos as propriedades de material para dar início ao processo 

de simulação. O material utilizado para impressão das guias é o filamento termoplástico ABS (Acrylonitrile Butadiene 

Styrene) e, a fim de simular o parafuso utilizado para fixar a guia ao osso, foi imposta uma condição de contorno de 

engaste próximo ao centroide da guia, ilustrado pela imagem 5. Os valores de propriedade do material foram obtidos 

em Silva (2017) estão apresentados na tabela 1. 

Tabela 1. Propriedade de material da guia. 

 E(MPa) v σlim(MPa) 

Guia  1681,5  0,37  30  

Onde E = Módulo de elasticidade; v = Coeficiente de Poisson; σlim = Tensão de Von Mises limite até atingir a fratura. 
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Figura 5. Condição de contorno de engaste simulando a ação de um parafuso (esquerda) e carregamento de pressão simulando os esforços 

transmitidos do formão à guia (direita).  

 

 Para simular os esforços nas fendas, foi definido o carregamento do tipo pressão com valor 13MPa de magnitude 

e aplicado nas superfícies que compreendem a área das fendas, como pode ser visto também na figura 5. Esses 

valores foram obtidos através do do trabalho desenvolvido por Marques (2022), que realizou simulações em 2D do 

contato entre o formão e o osso a fim de ser observado os valores de tensão que são transmitidos à guia durante o 

precedimento de OPA. 

 

2.4. Melhoria da guia 

 

 A partir dos resultados obtidos com a simulação dos esforços na guia original, foram criados os critérios para 

melhoria do modelo. No ABAQUS, esses resultados são apresentados seguindo um padrão de cores onde as áreas na 

cor azul (principalmente azul escuro) estão sofrendo tensão miníma, enquanto as áreas em vermelho estão sofrendo o 

valor máximo da tensão de Von Mises pré estabelecida para o material em questão. 

 

 No ABAQUS é possível realizar scripts na linguagens de programação Python, podendo auxiliar de diversas 

maneiras na automatização de diversas funções do software. Partindo disso, utilizamos um script, ilustrado abaixo, 

seguindo as informações presentes em Manual (2012), a fim de automatizar a modificação da guia cirúrgica. Partindo 

do resultados da simulação, o código cria um conjunto com todos os elementos que compreendem um intervalo de 

tensão de Von Mises de interesse. Com esse conjunto criado, fazemos uma cópia do modelo original e, por fim, 

excluímos os elementos presentes dentro do conjunto. 

 

### ACESSANDO O ODB E CRIA ### 

# Acessa a sessão aberta 

odb = session.openOdb(name='guia_original.odb',readOnly=True)  

# Acessa o assembly do odb 

S_Assembly1 = odb.rootAssembly 

# Acessa todos os elementos 

todos = odb.rootAssembly.elementSets['ALL ELEMENTS']  

TensaoFieldArray = odb.steps['Step-1']. 

frames[-1].fieldOutputs['S'].getSubset(region=todos) 

Tensoes = TensaoFieldArray.values 

 

# Guarda os elementos que serão retirados 

lista_elementos_out = []  

for StressValue in Tensoes: 

    if StressValue.mises < 5.16: 
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        lista_elementos_out.append(StressValue.elementLabel) 

 

### CRIA O NOVO MODELO E MANIPULA A MALHA DA PARTE ### 

 

novo_Modelo = 'Model-2' 

mdb.Model(name=novo_Modelo,objectToCopy=mdb.models['guiaTeste01']) 

S_Model2 = mdb.models[novo_Modelo] 

S_Assembly2 = S_Model2.rootAssembly 

S_part = mdb.models['Model-2'].parts['PART-1'] 

 

# CRIAR SET NA PARTE COM ELEMENTOS QUE SERÃO ELIMINADOS 

S_part.SetFromElementLabels(name='SET-Aspereza_Topologia_2',  

elementLabels=lista_elementos_out) 

 

Inicialmente, procuramos fazer a retirada de cerca de 10% do volume da guia original. Para isso, foi calculado o 

valor de tensão que representaria a retirada dessa porcentagem de material para que este valor fosse posteriormente 

inserido no script de otimização. Para fins de nomenclaturas, nomeamos a guia original com M1 e a guia pós otimização 

pelo script de M2.  

 

 A tabela 2 apresenta a porcentagem da tensão limite de escoamento total (43MPa) necessária para a remoção de 

uma determinada quantidade de volume da guia original. No contexto deste estudo, conduziu-se uma nova simulação 

com uma redução de volume de 10%, com o objetivo de analisar os efeitos e potenciais impactos que essa redução 

possa causar ao modelo. 

Tabela 2. Porcentagens de retirada de volume em relação à guia original. 

% tensão 
total 

Guia Nel Vol Delta_Nel Delta_Vol 

100  M1 39557 42014,62  - - 
12  M2  35286  37681,41   -10,79707763   -10,31357656  

Onde Nel = número de elementos; Vol = Volume em mm3; Delta_Nel = porcentagem de elementos retirada; 

Delta_vol = porcentagem retirada de volume. 

 

 Para garantir este novo modelo da guia (M2) esteja apto a uma nova simulação de esforços, é crucial realizar um 

processo cuidadoso ao remover os elementos da guia original (M1). Após a remoção, faz-se necessário seguir um 

protocolo de correção de malha no MeshMixer, observado na figura 6, que visa corrigir as imperfeições no modelo. 

Este procedimento é essencial para garantir que a nova simulação transcorra sem erros. A correção da malha ajuda a 

mitigar possíveis distorções e erros numéricos que podem surgir durante o processo de modificação da guia, 

assegurando assim resultados confiáveis e informações precisas para o aprimoramento bem-sucedido do dispositivo. 
 

  

Figura 6. Modelo da guia M2 logo após aplicado o script à esquerda e com intervenção mínima para correção dos erros à direita.   
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3. Resultados 

Para a utilização de todos os programas presentes neste trabalho, as configurações da máquina utilizada foram: 

Notebook Samsung Expert X50 NP350XBE; Processador Intel Core i7 8565U; 8GB de memória RAM; SSD 1TB; Sistema 

operacional Windows 10; Placa de video dedicada GeForce MX110. 

 

 A simulação dos esforços de tensão realizada na guia original (M1) dentro do ambiente do ABAQUS levou cerca de 

02min43seg. Como pode ser visto nos resultados apresentados pela figura 7, as áreas que sofreram maiores tensões 

foram as compreendidas entre as fendas "ilíaca" e "coluna", mais acentuadamente em torno da fenda ilíaca. Por outro 

lado, as áreas mais afastadas das fendas sofreram uma tensão menor ou praticamente nula. 

 

 

Figura 7. Resultado dos esforc¸os de tensao na guia original (M1).  

Como dito anteriormente, a partir desses resultados foi aplicado o script, descrito na seção anterior, no próprio 

ambiente do software ABAQUS que reduziu cerca de 10% do volume total da guia M1. Este novo modelo da guia foi 

novamente submetido à simulação, que durou cerca de 06min41seg, com os resultados apresentados da figura 8. Pode 

ser notado que houve pouca diferença da disseminação das tensões comparado à guia M1. As áreas próximas às fendas 

seguem sendo as mais afetadas com a tensão diminuindo nas regiões que mais distantes. A tabela 3 ilustra a 

porcentagem de volume que representa a tensão máxima (plasticidade) sofrida pelas guias M1 e M2. 

Tabela 3. Porcentagem de volume que sofreu plastificação nas guias M1 E M2. 

Guia Vol_total Vol_plast Porcentagem  

M1  42014,62  5239,81  12,47139686  
M2 38235,64   5297,23   13,85416852  

 

 

Figura 8. Resultado dos esforços de tensão na guia após retirada de volume (M2). 
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4. Discussão 

Conforme fora notado nos resultados das simulações, as áreas mais distantes das fendas sofrem menos tensão, 

ao passo que se torna crítica em seu entorno. Este resultado é ainda mais agravado na parte inferior de ambas as guias, 

onde a área ao redor do plano de corte ilíaco é significativamente menor em comparação ao restante. Pode ser notado 

também o baixo aumento no volume, cerca de 1%, que sofreu plastificação.  

 

 Conforme o volume é removido, prevemos que uma área cada vez maior da guia seja afetada. Portanto, é de suma 

importância conduzir um maior número de iterações, abrangendo diferentes porcentagens de volume retirado, a fim 

de criar um perfil que permita identificar até que ponto essa redução pode ocorrer sem causar impactos significativos 

na integridade estrutural do modelo. Além disso, deve-se ter em mente que ao aplicar o código, é essencial não remover 

elementos que compõem as fendas, a fim de preservar seu formato original. Dado que a posição do parafuso age como 

um concentrador de forças, sua localização pode ter efeitos tanto positivos quanto negativos na região afetada. 

 

 Além disso, vale ressaltar que o processo de melhoria através do script não é algo trivial. Como pode ser visto nas 

figuras 7 e 8 as áreas de menor tensão (no espectro da cor azul) não se distribuem de maneira uniforme. Sendo assim, 

quando o código é aplicado e os elementos dentro da tensão de interesse são excluídos, gera-se um novo modelo com 

diversos erros na malha, como pode ser visualizado na figura 6. E, apesar do ambiente do ABAQUS fornecer uma 

funcionalidade de otimização topológica, isso não é aplicável neste caso, pois a retirada dos elementos é feita através 

de uma malha órfã que não fora construída inteiramente dentro do software. Dessa forma, antes de uma nova 

simulação, faz-se necessário retornar com este novo modelo no MeshMixer a fim de aplicar uma intervenção mínima 

para que esses erros sejam corrigidos e a simulação seja possível. 

 

 O percurso para uma otimização que seja ótima ainda se encontra em sua fase inicial, contudo já indica alguns 

passos a serem seguidos ou até mesmo refeitos. Como a própria confecção da guia, onde se nota a necessidade de uma 

maior espessura em algumas regiões específicas, como também uma área um pouco maior no entorno de algumas 

partes das fendas, principalmente na ilíaca, onde praticamente todo seu arredor sofreu plasticidade nas simulações. 
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